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BibleWorks Version 8

Kevin A. Purcell - kevin@kevinpurcell.org

BibleWorks 8 is a powerful and complex piece of soft-
ware.  It is not a comprehensive Christian library like 
some other programs.  But what it tries to do, it does 

very well.  So what does it try to do?  From their own web site 
http://www.bibleworks.com, BibleWorks (BW) is an “...original 
languages Bible software program for Biblical exegesis and re-
search.”  And like previous versions, the new Version 8 continues 
this powerful tradition.

	 I want to make it clear from the outset that I am 
a BW user and have been since my seminary days.  
The first time I saw a friend in Hebrew class “cheat-
ing” as the professor asked us questions about our 
vocabulary, I was hooked.  Unfortunately this ruined 
me for being motivated to learn Hebrew as well as I 
should have.  Fortunately BW can help people like 
me as it comes with a number of Hebrew and Greek 
grammar’s as part of the base package.  More are 
available to add on.  You might find your text book 
either in the included list or on the web site if you 
are taking a Hebrew or even Greek class.  And if you 
were a great student, BW will help you use all that 
you learned.  By the way, my friend wasn’t really 
cheating; I just accused him of it and the professor 
agreed he was smart to use it and even suggested we use 
similar tools.
	 When I first installed this new version of BW and 
fired it up I was a little disappointed that the program 
requires what they call “activation.”  Due to software 
piracy many providers are going this way.  What this 
does is the opposite of what it is intended to do.  The 
pirates work to crack the programs while honest users 
suffer the consequences.  Fortunately, BW activation is 
not that difficult to do and they do allow you to install 
it on multiple machines so long as you own them and 

only one person will be using the program at a time.  So 
no sharing with your friends, which probably shouldn’t 
need to be said, but it does.
	 After activating or choosing a trial period, you will 
be met with a registration screen and then a getting 
started screen.  There are a few videos that help intro-
duce you to the BW interface.  In Version 8 things are 
not very different from Version 7.  But if you have never 
used the program it is a good idea to watch all of them.  
BW can be complicated and intimidating to first time 
users. There are so many buttons and boxes.  But like a 
747 jumbo jet is more complicated than an old biplane, 
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two-seater, it is also much more powerful.  Similarly, 
BW does original language study and Bible text search-
ing and research like a 747 flies passengers.  Powerfully!
	 Another thing I like about BW is the more advanced 
help.  I have mentioned this in a previous article with 
regards to Version 7.  BW 8 continues this.  From the 
Getting Started screen or from the Help Menu, click on 
BibleWorks Study Guides.  There are too many links 
here to explain them all.  If you buy the program, do 
yourself a favor and spend a good amount of time each 
day for the first few weeks and work through these 
helps.  The BW Study Guides are like having a course 
in basic exegesis and Bible study.  While teaching you 
to use BW, they will also teach you to conduct a good 
study of both English and original language resources.
	 After working through the helps in the getting 
started guide, you will see a devotional screen.  My first 
thought was how simple it was.  No, that is not a com-
pliment.  I wanted to say ugly, but looking at it again it 
is not so much ugly as it is plain.  For some that will be 
good.

		 The devotions open to today’s date.  The content 
is “Bagster’s Daily Light” which is two bible read-
ings for each day; one is for morning and the other 
for evening.  You have a calendar that takes you 
to the different dated entries.  The version button 
selects which Bible version to use including Greek, 
Hebrew or Latin.  As the Help system says, you can 
use it not only as a daily devotion but as a way to 
keep yourself sharp in your original language study 
which can be helpful to advanced Greek and Hebrew 
students.
		 After closing the Daily Light, you finally find 
yourself at the main window of BW 8.  It is split into 
three basic parts including the Search Window on 
the left, the Browse Window in the middle, and the 
Analysis Window on the right.  You can change this 

layout slightly by going to the View Menu and select-
ing Stack Analysis/Browse Window.  a Button Bar and 
Menu Bar are located above the three windows.  The 
Buttons are customizable; so after you have used BW 
for awhile you can make it look the way you want 
putting the most used functions right there.  Like most 
software, hover over a button to learn its function.
	 In BW, you usually start by searching or enter-
ing text references.  BW has a unique method of doing 
searches.  Simple searches by entering text by itself will 
not work in BW. You have to enter extra characters to 
tell it what kind of search you are doing.  For example a 
simple search for the word grace if entered by itself, will 
produce an error window telling you how to properly do 
the search.  You have to enter a period before it telling 
BW you want to do an “and” search.  Unfortunately, 
you are doing an AND each time you search for just a 
single word.  If you want to search for Grace and Love, 
then you type “.grace love” without the quotes.  This is 
a little hard to get used to at first.  But you will get the 

hang of it.  Similarly, if you want 
to do a PHRASE search you use an 
apostrophe.  You would type ‘in the 
beginning” again without the quotes.  
And for an OR search you use the 
forward slash.  Type “/grace love” 
without quotes.
	 I’m not sure why BW doesn’t 
allow you to do a simple search 
without the period, apostrophe or 
forward slash.  It would be easier 
if you could just enter the text or 
quotation marks around phrases like 
almost every other program and like 
the one done in Google.  But while 
BW is complicated, it is also very 
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powerful.  An example of this is the Graphical Search 
Engine.  If you are a visual kind of person or want to do 
very complicated searches, then GSE is for you.  I do 
not have the space to explain it here, but suffice it to say 
that it does some pretty interesting things using boxes 
and lines connecting search words and phrases.  As you 
can see from the picture, this gets quite complicated.  
This example of a GSE is from the help files and is 
also included on installation.  You can open this search.  
What it does is help you to find two different kinds of 
verses in one search.  The first kind of verse will have 
the words “man” or “*ites”, and “anger”, “wrath”, 
“temper”, or “fury”.  The asterisk next to “ites” means 
that any word that ends in “ites”, like Hittites or Amor-
ites, will be found so long as it also has the other words.  
But thanks to the power of the GSE it will not only find 
those verses, but this search will also find verses that 
include the words “fear” and “Lord” or “God”.  This is 
just one example; there are many more.  The GSE will 
let you save searches and then later open them.  BW 
has a number of these installed.  Go to SEARCH and 
the click GRAPHICAL SEARCH ENGINE and then 
once in the GSE click FILE and then OPEN.  So if you 
wanted to find the verses that had a certain Greek word, 
like “agape”, and then also had the word “love” in the 

KJV, then the GSE will help you do 
this.
	 In middle of the BW window 
you find the Browse Window where 
you can read or browse the Bible.  It 
has its own mini button bar that lets 
you select texts to study and how they 
are displayed.  You can display verses 
in multiple versions or a single ver-
sion showing the passage context.  You 
choose between the two modes by click-
ing the Toggle Browse Mode Button, 

which is the pair of feet on the mini button bar.  If you 
are in the mode that displays multiple versions and want 
to add other versions, you can either type the three letter 
shortcut in the Search Window or go to the View Menu.  
Select Choose Display Version(s).  In that menu you can 
also customize other aspects of the user interface.
	 Like many programs, BW 8 uses the right click ex-
tensively.  In the Browse Window, you can right click on 
the various parts of the displayed text to do things like 
search the Bible, look up words in lexicons and diction-
aries, copy text, etc.  There are a huge number of things 
you can do directly from the right click menu. Also, 
without even clicking anything a popup window will 
display information depending on what you are hover-
ing over with the mouse.  For example in the KJV and 
NASB (NASB’s three letter identifier is either NAS for 
the original or NAU for the updated 1995 version) you 
will see entries from corresponding Strong’s entries.  If 
it is Hebrew or Greek, then you will get a simple mor-
phology with the translation.  A morphology is a com-
prehensive explanation of the Greek or Hebrew word’s 
definition and grammatical information like tense, etc.
	 As you move your mouse over the words in the 
Browse Window, you will also notice that the third 
window is changing.  This is the Analysis Window and 

it changes based upon what your mouse 
cursor is hovering over.  For example, 
if you have the cursor over any part of 
John 3:16 in the Holman Christian Stan-
dard Bible (CSB), then it will give you 
the translation notes for that verse.  If 
you move down to the KJV then you get 
not only the Strong’s entry for that word, 
but also the Matthew Henry Commen-
tary entry for that verse.  Right click in 
the Analysis window and you can either 
customize the view or copy the contents 
among other things.
	 In the Analysis Window there 
are a number of tabs each with very 
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useful contents.  The 2nd tab is a labeled Resources and 
is a summary of all the resources for the verse showing 
in the Browse Window.  For example, with John 3:16 
it lists all the words in all the Greek Lexicons that are 
included in BW.  They are highlighted in blue.  Below 
that, highlighted in pink, are the Grammars that have 
information about that verse.  And below that are other 
references highlighted again in blue.  You can view 
these in a single summary.  Click on the entries and 
the Resources window opens showing that entry in the 
Lexicon or Dictionary.
	 You will notice more tabs labeled Summary, Lexi-
cons, Grammars, References, and Options.  Click the 
other tabs next to the summary tab and you get check 
boxes that let you change which resources are shown in 
the Summary tab.
	 If you have read my other reviews of Bible Study 
Software, you will know that I have been critical of 
Notes features.  BW gets it right.  A couple of other 
programs do it better, but none with the range or scope 
of features that BW offers.  For that reason, of all the 
programs I have used and reviewed, I choose to keep 
my own study notes in BW.  I use other programs in 
addition to BW to do digital Bible Study.  I have many 
programs that let you keep notes, but I have found that 
BW Notes are simple and reliable.  
They are also easy to backup and can 
be read in Microsoft Word or other 
word processors since they are basi-
cally just Rich Text Format files.
	 You will find the Notes feature 
in the Analysis Window next to the 
Resources tab.  You can either keep 
chapter specific notes or verse specif-
ic notes.  You can keep both, but that 
requires you to toggle the Chapter 
check box at the top of the Window 
or you can double click a portion of 
the status bar at the bottom.
	 The Notes window is a power-
ful word processor.  It also lets you 
save notes that can later be displayed 
each time you open the verse or 

chapter in the Browse Window and have 
the Notes tab displayed in the Analysis 
Window.  There are a few features that I 
especially like.  You can save your notes 
and they will be displayed regardless of 
which translation you are viewing.  Some 
programs make your notes specific only to 
a certain translation.  If you put a note on 
John 3:16 in the KJV it, in BW it will also 

show up in the NIV.  My notes are seldom translation 
specific.  When they are, I just state it in the note itself.
	 BW8 lets you customize where the notes are kept.  I 
change this so that they will show up in my Documents 
folder.  I want to be able to quickly find them because 
they are stored in a directory structure that matches the 
books of the Bible.  You will have a Gen folder for Gen-
esis with one file for each note whether it is a chapter or 
a verse note.
	 Next to the Notes tab is the Editor tab where you 
can edit topical documents like sermons or devotions.  
They will be stored in the same place as your notes.  If 
you want, you can also open these in a word processor.  
That way you can write your sermon in BW8 and then 
open it later in Word and format it so that it looks the 
way you want.
	 From the Notes or Editor tab, you can manipulate 
text and paragraphs just like a word processor.  You can 
also insert verses with the click of a button.  And you 
can add a hypertext link to a verse that will popup when 
your mouse cursor hovers of it.  If you type John 3:16, 
then click on the Add/Modify Hyperlink Text button (a 
small chain link) and a dialogue box pops up to let you 
configure the selected text as a hyperlink to that verse.  
If I could improve the BW Notes and Editor features I 

http://www.myflock.com
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would make this hyperlink automatic.  Other programs 
have the capability recognize that you are typing a 
verse reference and automatically turn it into a hyper-
link.
	 Other tabs are for cross references, statistics, words 
lists, and context.  These are useful new tools in Ver-
sion 8 which help users find out information about the 
text or quickly looking up cross references for the given 
text.  The second to last tab shows information about 
the currently selected translation.
	 A new feature in the Analysis Window is the last 
tab which gives you a second Browse Window.  This 
way you can open two different texts in one program 
window.  Before, you had to open a separate window 
via the menu.  This is handy to have the main Browse 
Window in the Single Verse interlinear mode with this 
secondary Browse Window in the Multiple Verse mode 
showing the verse’s context.  And then open a “float-
ing” notes window so you can have all three on screen 
at the same time.  I will use this feature a lot.
	 Each time BibleWorks releases a new version they 
do something that not many other vendors do.  They 
take many of the resources that were extra cost add-ons 
in the previous version and make them part of the base 
package in the new versions.  Version 8 follows that 
with dozens of new resources.  They also have many 
new optional modules that you can buy.

	 Unfortunately, the Lord giveth and the Lord ta-
keth away.  In Version 8 there are a few modules taken 
away, including one of my favorites, Robertson’s Word 
Pictures.  With ERMIE (see below for an explanation) I 
will have to link to it in another software program.
	 A few months ago I wrote an article wishing for 
a new STEP, which was a standard book format that 
vendors could use to distribute their books so that they 
could be used on other vendor’s book readers.  The very 
next month, Craig Rairdin of Laridian gave a thoughtful 
explanation of why this is not likely going to happen.  
But the next best thing is for one vendor to make their 
program play nice with others’.  BW does that with the 
External Resources Manager (AKA ERMIE).  ERMIE 
is a tool that lets you open other programs to find con-
tent related to the verse or word you have selected in 
BW.  For example, if you own a great commentary in 
Logos, you could set up a link from within BW to open 
Logos to the verse you are studying.  Other options are 
opening web sites or other software.  This is a huge 
plus.  I have just started learning to use this, but I plan 
to work with it as BW does not try to include a lot of 
extra commentaries.
	 Another new feature in Version 8 is the ability to 
read your text aloud if you have Vista.  Choose Tools 
menu and then select Viewing the Text and then Read 
Text.  A dialogue box opens.  You can enter the verse or 

http://www.nacba.net/
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range of verses you want read and in which translation.  
You can even have it read to .wav which is an audio file 
format that you can either burn to CD, listen to on your 
computer, or convert to MP3 for listening to on an MP3 
player.
	 Two great tools to help study the text and original 
languages are the Vocabulary Flashcard Module and 
the Diagramming Tool.  Diagramming is a great way to 
“see” the text.  BW has a powerful diagramming tool.  
Along with it comes the Leedy Greek NT Diagrams.  
These are a set of diagrams of every Greek verse.  You 
can use these as they are to study the relationships of 
words and phrases in a text.  Sometimes this helps you 
find the outline of the text that you might not see when 
just reading in the Browse Window.  But better than us-
ing the Leedy diagrams, do the work yourself.  BW even 
teaches you how with a nice Tutorial Help file.  I like to 
diagram my sermon text in English, but you can do it in 
Greek as well.
	 The Vocabulary Flashcard Module is what it sounds 
like – a digital flash card system for learning vocabulary 
in the original languages.  It even comes with word lists 
from the included grammar books.  If you are learning 
Greek or Hebrew, or just want to brush up, load it up 
from the Tools Menu.  Go to the Language Tools menu 
under Tools and select it.
	 The module will show the word, pronounce it for 
you, and then show the meaning in English.  To show 
the meaning you simply use your arrow keys or the 
arrow buttons on the toolbar.  This module will also let 
you create your own verse list and record pronunciation 
files.  
	 One feature I consider a must in bible study soft-
ware is the ability to author your own works that will 
easily show up in the program when you are studying.  
I’ve already mentioned the notes and editor features.  
But BW also gives you the tools to create your own 

translation or a commentary that can be displayed in 
the Browse Window.  This is not simple but anyone can 
learn how using the comprehensive descriptions in the 
Help system.
	 BW maps are attractive and informative.  There are 
plenty of other tools in BW 8 as well.  If you want to see 
what is new, the check out the list at their home page at 
http://www.bibleworks.com/content/new.html.
	 The big question when discussing a Bible Software 
update like BW 8 is this: is it worth upgrading or not?  
I would say it definitely is.  The new Analysis window 
alone makes it worthwhile. If you are trying to learn the 
languages then the new grammars and vocabulary mod-
ule are useful as well.  There are plenty of new features.  
Check out the link above to see if any of them would be 
of use to you.  But the new modules listed at the above 
link alone will make it worth the cost.  If you have ver-
sion 7, it will only cost $149 to upgrade.  From version 
6 the cost is $175.  If you have version 5 or earlier you 
will have to pay the full price of $349.  Students should 
look out as some campuses will have special deals avail-
able to students and faculty.  That is how I got my first 
version.  If you, like me, used the CD version, having 
the entire program on a single DVD is nice.  You have 
that option with this upgrade.

www.givenowbutton.com
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	 The other big question is should I 
pick BW over another program if I am 
in the market for my first professional 
quality Bible study program.  That 
depends a lot on your needs.  If you 
primarily want to read the Bible in Eng-
lish, have access to a lot of books like 
commentaries or other works unrelated 
to language study, then probably not.  
But if you are a serious student of the 
word and like to study the Bible in the 
original languages, then BW 8 is one 
of the best available.  And with ERMIE 
it plays well with others.  I use it along 
with a few other programs to do com-
prehensive study and writing.
	 My only real complaints are the 
requirement to activate the software, the 
inability of the Notes and Editor to au-
tomatically hyperlink Bible references, 
and the very plain looking Daily Light 
window.  But I love the new Analysis 
Window and the powerful External 
Resources Manager or ERMIE.  And 
one thing I have not mentioned is that 
BW is one of the fastest programs.  It 
opens quickly making it great to quickly 
find a reference without having to have 
an extra system tray resource running all 
the time.  Instead BW8 has the Popup 
Verse Copy window, a little window 
that you can use to copy text into a word 
processor.  Find it under Tools, Import-
ing/Exporting Information.  That way 
you can be in your word processor and 
copy verses into a document without 
going back to BW and navigating to the 
reference, selecting it and then copying.
	 BW8 also does its searches ex-
tremely fast if they are simple.  Even 
complex searches are pretty quick.  And 
BibleWorks is great at searching in 
original languages as well as complicated or simple English 
language searches.  I have not even mentioned all the things 
you can do in the Search Window.  If it you get lost in the 
complexity of BibleWorks – and it is complex – just open 
the Help files or watch the Getting Started videos.  BW8 has 
some of the best help features in the industry.
	 If you need further help with BibleWorks or want to 
discuss this review, come over to www.Christ-Tech.com, 
a great resource for Christian Technology on the web.  We 
post a lot of useful information about new technology, give 

helpful “howto” articles, and discuss the latest in Christian 
Technology.  The forum has places to interact with oth-
ers.  We are just getting started so please register and then 
post some questions, ideas, thoughts or even tell me what 
you think of BibleWorks 8 if you are using it already.  If 
not, what do you want to know about it.  I will try to give 
you some help.  And I’m also looking for others to help me 
make this site a really great resource for the Christian Tech-
nology world.

http://www.sermonspice.com

